Description

2D Consolidation
under a Strip
Footing

For LUSAS version: 20.0

For software product(s): | Any Plus version.

With product option(s): Nonlinear, Dynamic.

Description

The pore water pressure 5]
dissipation and
settlement in a soil

following the application oS
of a distributed load is to

be investigated.

_

Horizontal displacement
at the left edge is
restrained to model the

100m }

Young’s modulus of the soil ~ E= 34.7 x 10® kN/m?

Centre line ——

Symmetrical boundary Poisson’s ratio v=0.35

condition. Vertical Density =19t
displacement at the base Bl modulus of K 223 10° KNI
of the soil is restrained as ulkemodulus of water w=eex m
the soil rests on solid Void ratio e=1174

rock. The pore pressure Unit weight of water 7= 9.812 kN/m®

at ground level is Soil permeability ky=ky=kz=1.0 x 10® m/s

prescribed to zero.

Units of kN, m, t, s, C are used throughout.




A

Modelling

2D Consolidation under a Strip Footing

Objectives
The required output from the analysis consists of:

O Settlement at the centre of the footing with time.

O Pore pressure distribution immediately after application of the load (undrained
response)

O Pore water pressure dissipation with time at the centre of the footing

Keywords

2D, Plane Strain, Consolidation, Pore Water Pressure, Time Stepping, Nonlinear,
Transient, Settlement, Two Phase Materials, Default Assignments, Graphs

Associated Files
Associated files can be downloaded from the user area of the LUSAS website.

U pwp_modelling.lvb carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller, see the heading Running LUSAS
Modeller in the Introduction to LUSAS Worked Examples document.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter a File name of pwp

e Use the default User-defined working folder.
e Ensure an Analysis type of Structural is set.
e Select an Analysis Category of 2D Inplane
e Set Model units of kN,m,t,s,C

e Leave the Timescale units as Seconds

e Select a Startup template of 2D Plane Stress.




| Attributes
|Mesh >
Surface...

Modelling

e Ensure the Layout grid is set as None
e Enter a Title of Consolidation under a Strip Footing

e Click the OK button.

Note. The Undo button may be used to correct a mistake. The undo button allows any
number of actions since the last save to be undone.

Mesh Definition

Since this analysis requires the modelling of pore water pressure, plane-strain two
phase elements will be used.

e Select Plane strain two phase, Quadrilateral, Quadratic elements. Ensure the
Regular mesh option is selected with Automatic chosen so that Modeller will use
the mesh divisions assigned to each line.

e Give the attribute the name Plane Strain Two Phase and click the OK button to
add the mesh attribute to the & Treeview.

e In the @ Treeview click on the mesh attribute Plane Strain Two Phase with the
right-hand mouse button and select the Set Default option. This will ensure all
newly created surfaces will be assigned the elements defined in this mesh attribute.

Material Properties

For consolidation analysis both the elastic and two-phase soil properties need to be
defined. The overall ‘equivalent’ bulk modulus of the soil is related to the bulk
modulus of the pore fluid and the bulk modulus of the solid soil particles by the
formula:

1 on,@n_n
Ke Kf Ks Kf

Where
Ke is the equivalent bulk modulus of the soil
Kf is the bulk modulus of the pore fluid
Ks is the bulk modulus of the solid soil particles
n is the porosity of the soil

The porosity of the soil is related to the void ratio by the formula:




| Attributes

2D Consolidation under a Strip Footing

Material
Isotropic...

€
Porosity N =——=0.54
1+e

e Enter the isotropic material properties for the soil as Young’s Modulus 34.7E3,
Poisson’s Ratio 0.35 and Mass density 1.9 (Note that the ‘Mass density’ field is
renamed to be ‘Fully saturated soil density’ when the Two phase tab is selected)

e Click on the Two phase check box on the top of the dialog.

Isotropic X

[CIPlastic [Ccreep [pamage [shrinkage [ Viscous Twophase [ ]Ko Initialisation
Elastic Two Phase

(® Fully saturated Value
(O Partially saturated Bulk modulus of solid phase 2.2e6
. Bulk modulus of fluid phase 2.2e6
Dralr.'lmglﬁlllng curve definition TR 0E4
ane Hydraulic conductivity in global X direction 10e-9
- 3 Hydraulic conductivity in global Y direction 10e-9
Hydraulic conductivity in global Z direction 10e-9
Denstyoffiud [ LI
Define a
Fluid bulk modulus definition
(®) Absolute value
(O Factor
(:} Poisson's ratio of the undrained soil
|:| Define maximum suction pressure
[[] Define maximum cavitation pressure
] incompressible solid phase
Name | Fissured Clay v = (new)

-

II] Cancel Apply Help

e For a Fully saturated condition enter the properties as shown in the dialog above.

e Enter the attribute name as Fissured Clay and click the OK button to add the
attribute to the &' Treeview.

o In the €% Treeview click on the attribute Fissured Clay with the right-hand mouse
button and select the Set Default option. This will ensure all newly created features
will be assigned the properties defined in this material attribute.




| Geometry
| Surface >
| By Coords...
| Geometry
| Surface >
| By Coords...
| Attributes
[Mesh >
[Line...

Modelling

Feature Geometry

J Enter coordinates of (0, 0), (5, 0), (5, 10) and (0, 10) to define the soil under the
load. Use the Tab key to move to the next entry field on the dialog. When all
coordinates have been entered click the OK button.

J Enter the coordinates of (5, 0), (100, 0), (100, 10), (5, 10) to define the remainder
of the soil.

Mesh Grading

o Define a Line mesh with element type None and 16 divisions.
e Select the Spacing button.

e Choose the Uniform transition option and set the Ratio of first to last element to
0.1

e Click OK to accept the spacing properties.

e Give the attribute name as Null 16 Graded and click the Apply button to add the
attribute to the &% Treeview and keep the dialog active.

e Define a Line mesh with 12 divisions.

e Select the Spacing button.

e Enter the Uniform transition option and set the Ratio of first to last element to 5
e Click OK to accept the spacing properties.

e Give the attribute name as Null 12 Graded and click OK to add the attribute to the
A Treeview.

e Select the two horizontal lines of the larger surface as shown and assign the mesh
attribute Null 16 Graded

T3
E




2D Consolidation under a Strip Footing

Note. When the mesh is graded with the smaller elements at the wrong end of a line
/ the affected line(s) can be reversed

o Select the incorrectly oriented line and use the Geometry>Line>Reverse menu.

e Select the three vertical lines as shown (Use the Shift key to add to the initial
selection) and assign the mesh attribute Null 12 Graded

c

e Select any incorrectly oriented line(s) and use the Geometry>Line>Reverse menu.

The end result should be a mesh that looks like the above image

Supports

Assign the supports to the model.

e Select the vertical Line on the left-hand side of the model and drag and drop the
support attribute Fixed in X from the & Treeview onto the selection. With the
Assign to lines option selected click OK to assign the support attribute to All
analysis loadcases

e Select the 2 horizontal Lines representing the base of the soil and drag and drop the
support attribute Fixed in Y from the & Treeview onto the selection. With the
Assign to lines option selected click OK to assign the support attribute to All
analysis loadcases
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Loading
To define the distributed load:
| Attributes e Select the Face option and click Next
Loading...

e Enter loading of 3450 in the y Direction

e Enter the attribute name of Distributed Load and click the Finish button.




Modelling

e Select the top line on the left-hand side of the model and drag and drop the
Distributed Load attribute onto the selection. With the Assign to lines option
selected click OK to assign the loadcase attribute to All loadcases.

i AR N

Analysis Control

Undrained loading stage

—
—
—h
—
—_—

The undrained loading of the soil must be calculated to establish the initial conditions

of the consolidation analysis.

e Inthe @ Treeview expand Analysis 1 then right-click on Loadcase 1 and select
Nonlinear & Transient from the Controls menu.

Nonlinear & Transient

Incrementation
Nonlinear

Incrementation
Starting load factor
Max change in load factor

Max total load factor

Adjust load based on con

Iterations per increment

Displacement reset

Time domain

Initial time step
Total response time

Automatic time stepping

Common to all

et ]
—

Solution strategy
Same as previous

Max number of iterations

Residual force norm

Incremental displacement norm

Incremental LUSAS file output
Same as previous loadcase
Output file
Plot file
Restart file
Max number of saved restarts
Log file

Histary file

Max time steps or increments | 0

In the Incrementation section:

coce

12
[0.1

10

Advanced...

[[]Save arestart at the end of this control

Help

e Select the Nonlinear option and choose Manual incrementation.

e Select the Time domain option and chose Consolidation from the drop down list.




| Analyses

Loadcase...

| Attributes

Support...

| Attributes
| Loading...

2D Consolidation under a Strip Footing

Enter an Initial time step of 1
Enter Total Response Time of 1.
Set Max time steps or increments to 0.

Click OK.

Consolidation stage

To allow dissipation of the excess pore-water pressures a drainage path must be defined
which for this example is through the ground level of the soil. A new loadcase needs to
be created for this.

Click OK to create Loadcase 2

Click OK to acknowledge that assignments to loadcase 2 have been made from
assignments made previously that related to a range of loadcases. See the Help
button if more information is required.

Supports

Define a support to prescribe zero pore pressure.

Specify the Pore pressure to be Fixed.
Enter the attribute name as Drainage Path and click the OK button.

Select the Line at ground level on the right-hand side of the model (see following
mage) and drag and drop the support attribute Drainage Path from the &
Treeview onto the selection. With the Assign to lines option selected, choose the
From loadcase (nonlinear and transient) option to assign the supports to
Analysis 1 and Loadcase 2. Click OK.

daisisd
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Loading

Select the Prescribed displacement option and click Next

With the Total option selected, set the Pore Pressure to be Fixed and enter a
prescribed displacement of 0. Name the attribute Surface Excess Pore Water
Pressure and click Finish.




Modelling

o With the line at ground level on the right-hand side of the model still selected (see
previous image), drag and drop the loading attribute Surface Excess Pore Water
Pressure from the Treeview onto the selection for a Single loadcase named
Loadcase 2. The applied loading will be visualised as shown below.
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—
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—
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—
—
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—
—
—
—
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Analysis Control

Consolidation stage

With this consolidation problem an automatic time stepping procedure is adopted. This
is because consolidation is a typical diffusion process in which the field changes
rapidly at the start of the process before settling down to a steady state condition a
considerable time after the initial load is applied. The automatic time stepping
procedure enables the time step to be modified so that the small time steps required at
the start of the problem can be increased as the analysis progresses. In some cases the
overall response time can be orders of magnitude larger than the initial time step.

The initial time step is important since the early variations in pore pressure must be
accurately accounted for. Vermeer and Verruijt suggest the following criteria for
determining the initial time step where Ah is the minimum distance between nodes.

812
At > Lo (Ahy? = 58
6Ek 6 X 34.7TE3 x1E -8

x 0.14° ~100 secs
Note. The distance between two nodes can be determined by selecting the two nodes
and then picking the Tools> Mesh> Distance between Nodes menu item.

o In the & Treeview expand Analysis 1 then right-click on Loadcase 2 and select
Nonlinear & Transient from the Controls menu.
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Nonlinear & Transient

Incrementation Solution strategy
[ nonlinear [] 5ame as previous loadcase
Incrementation Manual ~ Max number of iterations 12
Starting load factor 0.1 Residual force norm 0.1
Max change in load factor 0.0 Incremental displacementnorm 1.0
Max total load factor 1.0 Advance
Adjust load based on convergence
: - Incremental LUSAS file output
Iterations per increment 4 [] 5ame as previous loadcase
Displacement reset OU‘DUt ﬁ'e 1
== Plot file 1
[ Time: domain
- Restart file 1]
Consolidation ~
Initial time step 100 Max number of saved restarts 0
Total response time 100.086 Log file -
Automatic bme stepping History file 1
[]save a restart at the end of this control
Common to all

Max time steps or increments | 50

OK Cancel Help

In the Incrementation section:

e Select the Nonlinear option and choose Manual incrementation.

e Select the Time domain option and chose Consolidation from the drop down list.
e Enter an Initial time step of 100

e Enter Total Response Time of 100E®6.

e Set Max time steps or increments to 50.

e Select the Advanced button in the Time domain section of the dialog.
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| File

Save

Running the Analysis

e On the Advanced time step
parameters dialog set the ‘Time step
increment restriction factor’ to 2

e Set the ‘Minimum time step’ to 100

e Ensure the ‘Maximum time step’ is
set to 100E6

e Ensure the ‘Minimum time step for
termination’ is set to 0

Advanced Time Step Parameters

Time step scale safety factor

|7. %

Time step increment restriction factor
Minimum time step 100
Maximum time step 100e6 £s
Minimum time step for termination 0

Exponent for increasing time step

Integration factor alpha

e Click OK to return to the Nonlinear Integration factor beta 1.0
and Transient control dialog. Integration factor gamma 0.5
e Click OK to set the loadcase control. e step rechacBons

Maximum step reductions

o ]

Saving the model

El Save the model file.

Cancel Help

Running the Analysis

&

El Open the Solve Now dialog. Ensure Analysis 1 is selected and press OK to run
the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...

Analysis loadcase results are added to the (5 Treeview.

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

U pwp.out this output file contains details of model data, assigned attributes
and selected statistics of the analysis.

U pwp.mys this is the LUSAS results file which is loaded automatically into
the Treeview to allow results processing to take place.

11



| File

New...

| File
[ Script >
| Run Script...

2D Consolidation under a Strip Footing

If the analysis fails...

If the analysis fails, the output file will provide information relating to the nature of the
error encountered. Any errors listed in the output file should be fixed in LUSAS
Modeller before saving the model and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully. You may
download this associated file from the user area of the LUSAS website.

O pwp_modelling.lvb this file carries out the modelling of the example.

gl Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as pwp

e Use the default User-defined working folder.
e Ensure an Analysis type of 2D Inplane is set.
e Click the OK button.

Note. There is no need to enter any other new model details when a script is run to
build a model, since the contents of the script will overwrite any other settings made.

To recreate the model, select the file pwp_modelling.lvb that was downloaded and
placed in a folder of your choosing.

El Solve the analysis to generate the results.

Viewing the Results

Loadcase results can be seen in the ‘Z Treeview. For a nonlinear analysis the last
results time step is set active by default.

crreperny
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| utilities
| Graph Wizard...

Viewing the Results

o If present, turn off the Geometry, Mesh and Attributes layers in the [= Treeview.

Settlement

o Inthe™ Treeview, right-click on the first load increment Time Step 0 and select
the Set Active option to view results immediately after the loading is applied.

e Click the Deformations button in the Treeview and select the Specify factor
option. Specify a factor of 1 and click OK to visualise the deformed mesh for the
first time step.

A graph of the deformation over time will be created using the graph wizard.

e Zoom into the left-hand side of the o

model and select only the node on L=t
the centre line representing the
bottom of the footing.
Graphing settlement
e With the Time history option
selected click Next
Firstly define the data to be used for :_»

the X axis.

o Selected the Named option and click Next

e Select Response Time from the drop down list and click Next
Secondly define the data for the Y axis.

e With the Nodal option selected and click Next

e Select Displacement from the Entity drop down list and DY from the Component
drop down list.

e The selected node number will appear in the Specified single node drop down list.
Click Next

For the X Scale enter Manual values of minimum 100 and maximum 10e6
respectively.

e Select the Use logarithmic scale option.

13



2D Consolidation under a Strip Footing

o Title the graph as Settlement under centre of footing

e Click Finish to display the graph of settlement over time under the centre of the
strip footing.

Settlement under centre of footing

05
£0.52
054 |-
056 -
058 |-

,0 6 -
062}
064 -
-0.66 |-
068 [

07}
072
074}
076 -
0.78

100
1000 f-
e
1e7

10000
100000 |-

—®— Displacement Y Node 724(10) / Response time{9)
E Close the graph window

Pore water pressure

The distribution of pore pressure is to be shown using contours.

e With Time Step O set active in the C Treeview, and with no features selected, click
the right-hand mouse button in a blank part of the view window and select

Contours to add the contours layer to the [ Treeview.

o Select Displacement from the Entity drop down list and PRES from the component
drop down list.

e Select the Appearance tab and for the Classic contour type press the Set button
and set the Interval to 250

e Click the OK button to exit the dialog, and again to display contours of the
undrained pore pressure distribution (Time step 0) immediately after the loading is
applied.

14



| utilities

Graph Wizard...

Viewing the Results

Analysis: Analysis 1

Loadcase: 1:Loadcase 1, 1:Time Step 0 Time = 0.000000E+00
Results file: pwp_from_script~Analysis 1.mys

Entity: Displacement

Component PRES (Units: kN/m?)

Maximum 3.14978E3 at node 751
Minimum -979.176 at node 755

e To observe the distribution of pore water pressure at a particular time after the

application of loading, activate the appropriate time step from the (& Treeview by
selecting the time step with the right-hand mouse button and choosing the Set
Active option.

Note. The dissipation of pore water pressure over time may also be observed by
creating an animation of the contour display.

Graphing pore water pressure

The dissipation of pore water pressure under the footing is to be presented on a graph.
e Inthe &= Treeview turn off the display of the Contours layer.

e Select the node on the centreline under the footing as before.

e With the Time history option selected click Next

Firstly define the data to be used for the X axis:

e Selected the Named option and click Next

e Select Response Time from the drop down list and click Next

Secondly define the data for the Y axis:

e With the Nodal option selected and click Next

e Select Displacement from the Entity drop down list and PRES from the
Component drop down list.
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| Utilities

Graph Wizard...

2D Consolidation under a Strip Footing

e The extent to be graphed will be set to Specified single node and the node selected
will be seen in the Specify node field. Click Next

e For the X Scale ensure that Manual values of minimum 100 and maximum 10e6
respectively are used.

e Ensure the Use Logarithmic scale option is selected.
e Forthe Y Scale leave the values as the defaults.
e Title the graph as Dissipation of pore water pressure

o Click Finish to display the dissipation of pore water pressure over time under the
centre of the strip footing.

Disspation of pore water pressure
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10
1000
10000
100000
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1e7

—#— Node 745(4) / Response time(3)

E Close the graph window.

Graphing effective stress in soil

As the pore water dissipates the load is carried by the soil. The increase in effective
stress in soil can be observed on a graph of effective stress against response time.

e Ensure the node on the centreline under the footing still selected.
e With the Time history option selected click Next

Firstly define the data to be used for the X axis

e Select the Named option and click Next

e Select Response Time from the drop down list and click Next

Secondly define the data for the Y axis

16



Viewing the Results

e With the Nodal option selected and click Next

e Select Stress from the Entity drop down list and SY from the Component drop
down list.

e The extent to be graphed will be set to Specified single node and the node selected
will be seen in the Specify node field. Click Next

e For the X Scale ensure that Manual values of minimum 100 and maximum 10e6
respectively are used.

e Ensure the Use Logarithmic scale option is selected.
e Forthe Y Scale leave the values as the defaults.
o Title the graph as Effective soil stress

e Click Finish to display the graph of the effective soil stress over time under the
centre of the strip footing.

Effective soil stress
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This completes the example.
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